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You can type French accents on Windows using different keyboard layouts like International and UK Extended.For Apple computers, typing French accents is simple with the Option key, KeyCaps, or Special Character Palette.Linux users can use the Character Palette or Compose Key to easily type French accents. You don't need to buy a French
keyboard or any software to type French accents. There are several different ways to type them on Windows, Apple, and Linux computers. You have several options, based on your computer and current keyboard: If you currently use the English-U.S. keyboard layout, the international keyboard is far and away your best option for typing accents. It is
not a separate keyboard, just a Windows setting.If you use an English-U.K. keyboard, the U.K. extended keyboard is the best.Your other options are the French keyboard, the Canadian French keyboard, and ALT codes. Depending on your operating system, you can choose between: Option key accentsKeyCapsSpecial character paletteSetting the
language of your operating system to French For U.S. English keyboard users, the international keyboard (which is not a physical keyboard, but rather a simple Control Panel setting) is the easiest and most convenient method for typing French accents because it maintains the QWERTY layout, with just a few changes and additions: To type accent
grave (a, e, etc), type ~ (to the left of 1) then the vowel.Accent aigu (é), type ' (single quote) then e.Cédille (¢), type ' then c.Circonflexe (&), type ~ (shift + 6) then e.Tréma (6), type " (shift + ') then 0.To type French quotation marks « » use ctrl + alt + [ and ], respectively. The minor disadvantage of the international keyboard is that when you want to
type the "helping" character (e.g., single or double quotes) by itself rather than above a vowel, you have to type the symbol then hit the space bar. For example, to type c'est, type ¢ then ' then hit the spacebar then type e s t. It takes a little while to get used to typing that extra space when you just want to type ' or " Troubleshooting the international
keyboard If you are plagued by strangeness such as cést when you try to type c'est, re-read the note above. In order to use the international keyboard to type French accents, you need to select that keyboard layout. If you currently use a UK keyboard, you will probably find the UK extended keyboard the easiest way to type French accents. The
keyboard layout will be maintained, but you can type most accents with the AltGr key, which is located to the right of the spacebar. To type accent grave (a, &, etc), type ~ (to the left of 1) then the vowel.Accent aigu (&), click AltGr and e at the same time.Cédille (g), click AltGr and c at the same time.Circonflexe (&), click AltGr and ~ at the same time,
then the vowel.Tréma (0) click AltGr and " at the same time, then the vowel. In order to use the UK extended keyboard to type French accents, you need to select that keyboard layout. Close up of a white french azerty computer keyboard. Delpixart / Getty Images Plus The layout of the French keyboard, known as AZERTY, is somewhat different than
the layouts of other keyboards. If you're used to QWERTY, I recommend that you use the international keyboard.Otherwise, with the French keyboard layout, you'll find - among other changes - that the A and Q have switched places, W and Z have switched, and M is where the semi-colon used to be. In addition, numbers require the shift key.On the
other hand, you can type the grave accent (a, €, i) and acute accent (é) with a single key, and the other accented letters with a combination of two keys: To type anything with a circumflex (&, &, etc), type ™ then the vowelFor a tréma, (3, €, etc), type ~ and the vowel In order to use the French keyboard to type French accents, you need to select that
keyboard layout. French Canadian keyboard. Public Domain / Wikimedia commons The layout of this keyboard is similar to QWERTY, making it somewhat simpler if that is what you are used to (though I still believe that the international keyboard is better).Typing accents on the Canadian French keyboard is fairly simple: To type an acute accent (é),
type * (next to the right-hand shift key) and then eTo type a grave accent (a, €, 1), type ' (apostrophe / single quote) then the vowelThe circumflex " and tréma "~ are in the upper-right corner, side by side next to the enter keyFor ¢, type , (left of "enter") and then c In order to use the Canadian French keyboard to type French accents, you need to select
that keyboard layout. In order to use one of these alternate keyboard layouts, you need to add it to Windows. Once you've done this, you can either set it as your default keyboard or use alt plus shift to toggle between two or more layouts. The way to do this is slightly different for each operating system. Open Control PanelUnder "Clock, Language,
and Region," click "Change input methods"Click "Options" to the right of your languageClick "Add an input method"Scroll down to the language you want to add, click + next to it, then select the layout*Click OK in each dialog window. Open Control PanelUnder "Clock, Language, and Region," click "Change keyboards or other input methods"Click
"Change keyboards"Click AddScroll down to the language you want to add, click + next to it, then select the layout*Click OK in each dialog window.To use the layout, click the language input button on the taskbar (it probably says EN) and select it. Open Control Panellf in Classic View, click "Control Panel Home" in the upper-left cornerUnder "Clock,
Language, and Region," click "Change keyboards or other input methods"Click "Change keyboards"Click "Add"Scroll down to the language you want to add, click + next to it, then select the layout*Click OK in each dialog window. Open Control PanelDouble-click "Regional and Language Options"Click "Languages"Click "Details"Click "Add"Under
"Input Language," pick the language you want to add*Under "Keyboard layout/IME" make your selectionClick OK in each dialog window. Open Control PanelDouble-click "Keyboard"Click "Language"Click "Properties," "Settings," or "Details" (whichever you see)Click "Add"Pick the layout you want to add*Click OK in each dialog window. Open Control
Panel (via Start menu or My Computer)Double-click "Keyboard"Click "Input Locales"Click "Change"Click "Add"Pick the layout you want to add*Click OK in each dialog window. *Layout names:International Keyboard: English (United States), US-Int'l UK Extended Keyboard: English (UK - extended) French Keyboard: French (Standard) French
Canadian Keyboard: French (Canadian) The best way to type accents on a PC is by using the international keyboard, which requires a simple control panel configuration - there is no keyboard to purchase or software to download. If you're really set against the international keyboard, you can type accented characters with ALT codes, which use the
ALT key and a 3 or 4 digit code. However, ALT codes only work with the numeric keypad, not the row of numbers across the top of your keyboard. So they won't work on a laptop unless you hit number lock to activate the number pad "built into" the right-side of your keyboard, which is a big hassle because then the letters won't work. Bottom line, if
you're on a laptop, choose a different keyboard rather than messing around with ALT codes. To type accents with ALT codes, hold down the ALT key, then on the numeric keypad type the three or four digits listed here. When you release the ALT key, the character will appear.a with grave accenta ALT + 133 A ALT + 0192a with circumflexd ALT +
131 A ALT + 0194a with trémaa ALT + 132 A ALT + 142a e ligatureae ALT + 145 /& ALT + 146¢ with cedillag ALT + 135 C ALT + 128e with acute accenté ALT + 130 E ALT + 144e with grave accenté ALT + 138 E ALT + 0200e with circumflexé ALT + 136 E ALT + 0202e with trémaé ALT + 137 E ALT + 0203i with
circumflexi ALT + 140 [ ALT + 0206i with trémai ALT + 139 I ALT + 02070 with circumflexd ALT + 147 O ALT + 02120 e ligaturece ALT + 0156 (E ALT + 0140u with grave accentu ALT + 151 U ALT + 0217u with circumflext ALT + 150 U ALT + 0219u with trémaii ALT + 129 U ALT + 154French quotation marks« ALT +

174 » ALT + 175Euro symbol€ ALT + 0128 To type accents on an Apple with the option key, hold down the option key while pressing the key(s) in bold in this list. For example, to type &, hold the option key while typing i, then release both and type e. To type i, hold option, type i, release and type i again. In these instructions, "and" means to keep
holding the option key and the first key listed while typing the second. "Then" means to release the option key and the first key before typing the second. acute accent é Hold option key and e then egrave accent a, €, U Hold option key and * then a, e, or ucedilla ¢ Hold option key and ccircumflex 4§, &, 1, 6, & Hold option key and i then a, e, i, o,
or utréma &, i, i Hold option key and u then e, i, or uoe ligature ce Hold option key and q To type any of the above as capital letters, add shift key to the first step. So for E, hold shift key, option key, and e, then e. French quotation marks « Hold option key and \» Hold option key and shift key and \ Euro symbol € Hold option key and shift key
and 2KeyCaps (OS9 and below) is similar, but it gives you a keyboard to click. Click on the apple on the top left of the screenOpen KeyCaps (a little keyboard will appear on the desktop)Hold down the option key - the accents will appear and you can click on them with the mouse.For example, to type 1, hold option, click °, type u. The accented
character will appear. Opening the special character palette to type accents on a Mac: Click edit in the menubarClick Special charactersSelect Roman from the View pulldown menuSelect the Accented Latin character paletteKeep the palette open for use in any application Using the palette: Place your cursor at the point in the document where you
want an accented characterClick the desired accented character in the paletteClick Insert at the bottom of the palette You can type French accents and immerse yourself in French at the same time on an Apple OSX by setting your system language to French so that your OS, as well as most Apple software, use French: Go to System
PreferencesChoose InternationalChange the system operating language to French Here are two ways to type accents in Linux: Character Palette (Ubuntu 10.04) Right-click on the top bar and click on "Add to Panel," select and add "Character Palette." The small arrow on the left will give a choice of palettes which you can modify to contain any
accented or other character required. Left-click a character, then hold down Control Key and type V to insert it at the cursor position. Compose Key Specify a particular unused key (e.g., the Windows key) to be the Compose Key, then you can hold down Compose Key and type e to get &, or 0" to get 6. The combinations are pretty intuitive. Where to
specify the Compose Key changes from system to system. On a SuSE installation, go to Control Center > Accessibility Options > Keyboard Properties > Options > Compose Key option. If you have an Android tablet or smartphone, you can download the app Smart Keyboard to get access to accented letters. Download the trial version or pro version of
the app and install it on your device Go to "Language and keyboard" and check the "Smart Keyboard" box Go to "Settings > Language > Current Language" and choose "English (International)" Go any app with a text box and press inside it in order to activate a popup menu. Choose "Input Method" and then "Smart Keyboard" You're all set! Now you
can type accents by pressing and holding the button for the unaccented letter for a moment. A list of accented letters will pop up for you to choose from.For example, to type a, press and hold the letter a, then choose a. To type é, e, &, or &, press and hold e, then make your selection. For ¢, press and hold the letter c. To type accented letters on an
iPhone or iPad, press and hold the button for the unaccented letter for a moment. A list of accented letters will pop up for you to choose from. For example, to type a, press and hold the letter a, then choose a. To type é, ¢, &, or &, press and hold e, then make your selection. For ¢, press and hold the letter c. Download Article Download Article This
method teaches you how to type French-accented characters using any computer, phone, or tablet. If you're using a phone or tablet, you can just press and hold the corresponding letter key to open a set of accent options. If you're using Windows, you can use the International Keyboard, which lets you easily switch between French and English. Most
Mac apps let you insert French characters the same way you'd do it on an iPhone, but others require keyboard shortcuts. 1 Tap the field in which you want to type a French-accented letter. This springs open your keyboard. Typing accented characters is generally the same regardless of keyboard app. You should be able to use this method on any
Android, iPhone, or iPad. If you're using the SwiftKey keyboard, you'll need to enable accented characters first. Here's how:[1] Tap the + to the left of the prediction bar on the keyboard. Tap Keys. Slide the "Accented Characters" switch to the On (purple) position. 2 Tap and hold the key with the letter that needs the accent. In about a second, you'll
see all possible accents for that letter. Don't lift your finger from the screen.[2] If you have an iPhone 6, 7, 8, or X-series with 3D Touch, use a light tap-and-hold instead of a hard press. If you press the key too hard, you'll see a cursor that can move around the screen rather than accent options. Advertisement 3 Drag your finger to the accented letter.
This highlights the selected letter.[3] 4 Lift your finger from the screen. The selected accented letter will appear.[4] Advertisement 1 Try using a shortcut key combination. If you're typing in a word processing app like Microsoft Word or similar, you can press a combination of keys to type French-accented characters. This is helpful for when you don't
need to type in French very often. Here's the list of shortcuts:[5] é: Press and hold Control+', and then type an e. € a u: Press and hold Control+", then press the key for the desired vowel. ¢: Press Control+, and then type a c. 4 €1 6 Gi: Press Control+", then press the key for the desired vowel. é i 6: Press Control+:, then press the key for the desired
vowel. 2 Open the Start menu and click Settings . If you need to type in French a little more often, you can use the International Keyboard. This keyboard lets you use fast keyboard shortcuts in any app to create accented characters without having to change your whole keyboard layout. 3 Click Time & Language. It's in the third row of settings.[6] 4
Click Language. It's in the left panel. 5 Scroll down and click your language. It's near the bottom of the right panel below the "Add a Language" option. Some buttons will expand below your language. 6 Click Options below your language. 7 Scroll down and click + Add a keyboard. It's under the "Keyboards" header in the right panel. A list of
keyboards will appear.[7] 8 Click United States-International or UK International Keyboard in the menu. This adds the keyboard to the list under the "Keyboards" header. You can now close the Settings window by clicking the X at its top-right corner. 9 Click your keyboard language on the taskbar. The language appears to the left of the clock in the
taskbar, which usually runs along the bottom of the screen. A menu will expand. For example, if you're using US English, click ENG US beside the clock. 10 Select ENG INTL. You are now using the international keyboard. 11 Open the app in which you need to type French accented letters. This can be a word processing app, a web browser, or any

~ and then type the vowel. € 1 6: Type a double-quote " and then the vowel. When the international keyboard is enabled, your apostrophe and quote keys will work a little different than normal. To type a regular apostrophe ' or ", you'll have to press the space bar right after. 13 Switch back to your normal keyboard. You'll usually only want to switch to
this keyboard when you have to type in French. To switch back, click ENG INT in the taskbar and select your default language. Advertisement 1 Open the app in which you need to type French accented letters. This can be a word processing app, a web browser, or any other app that allows typing. 2 Press and hold the key on which you want to add an
accent. A menu with different accent options above the key will appear. Don't lift your finger from the key.[9] 3 Press the number below the accent you want to use. You'll want to press the corresponding number while you're still holding the letter key down on the keyboard.[10] 4 Release your fingers from both keys. The selected accented letter now
appears. This method may not work in all apps, though it should work in most. If you're running into problems, you can use one of a combination of keystrokes to make the accents appear. Read on to learn how.[11] 5 Use the X Option key to insert accents. If the previous steps didn't work in the app you're using, you can use these shortcuts instead: é:
Press and hold \C Option+e, lift your finger from \C Option, and then press e. € a u: Press and hold X Option+", then press the key for the desired vowel. ¢: Press \ Option+C. a € 1 6 i: Press X Option+i, then press the key for the desired vowel. é i 6: Press X Option+u, then press the key for the desired vowel. Advertisement Add New Question
Question How do I put an accent over a letter? Marc Crabbé Google Suite Expert Marc is a translator and International Project Manager, who has been working in Google Suite for project management since 2011. As French keyboards aren't always available out of the French-speaking countries, consider using a Spanish keyboard if available as it
allows you to type most accents. Since I use a Spanish keyboard, I have almost all of the accents I need for special French characters, although I don't have dedicated keys as I would on a real French keyboard. Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Nicole Levine,
MFA. Nicole Levine is a Technology Writer and Editor for wikiHow. She has more than 20 years of experience creating technical documentation and leading support teams at major web hosting and software companies. Nicole also holds an MFA in Creative Writing from Portland State University and teaches composition, fiction-writing, and zine-
making at various institutions. This article has been viewed 118,256 times. Co-authors: 14 Updated: February 24, 2025 Views: 118,256 Categories: French Print Send fan mail to authors Thanks to all authors for creating a page that has been read 118,256 times. HTTA is reader supported. When you buy through links on our site, we may earn an
affiliate commission at no extra cost to you. Learn more. French has a standard set of 26 letters. In addition to these letters, French uses several accents. They are about five of them as listed below: L’accent aigu (é) - e with the Acute Accent.L’accent grave (a, €, u) - a, e and u with the Grave Accent.L’accent circonflexe or “chapeau” (4, &, 1, 0, ) - a,
e, i, 0, and u with the Circumflex Accent.La cédille (¢) - C with the Cedilla accent.Le tréma (€, i, i) - e, i, and u with the umlaut accent. This guide will teach you how to type special French Letters on a Mac or Windows PC using shortcuts on the English keyboard. There are different methods for typing these characters for different documents
depending on the Operating System you are using. You’'ll pick up each of these techniques in no time. Let’s get started. To type the Special French Letters with Accents on the English keyboard, press and hold the alt key, then using the numeric keypad type the Character alt code as below: To type French letter L’accent aigu (é), press Alt + 0201 for
uppercase or Alt+0233 for lowercase.To type French letter L’accent grave (a, €, i), press Alt + 0192, Alt + 0200, Alt + 0217 respectively for uppercase. To type lowercase, press Alt + 0224, Alt + 0232, Alt + 0249 respectively.To type French letter L’accent circonflexe (4, &, 1, 0, 01), press Alt + 0194, Alt + 0202, Alt + 0206, Alt + 0212, Alt + 0219
respectively for uppercase. To type the lowercase, press Alt + 0226, Alt + 0234, Alt + 0238, Alt + 0244, Alt + 0251 respectively.To type French letter La cédille (¢), press Alt + 0199 for uppercase and alt + 0231 for lowercase.To type French letter Le tréma (&, i, i), press Alt + 0203, Alt + 0207, Alt + 0220 respectively. To type the lowercase, press Alt
+ 0235, Alt + 0235, Alt + 0252 respectively. The table below lists all of the alternate characters for each of the Special French Letters - both lowercase and uppercase (i.e., small and capital letters). DescriptionFrench LettersKeyboard Alt codeFrench Letter E Acute - UppercaseEAlt + 0201French Letter e Acute - LowercaseéAlt + 0233French Letter
A Grave - UppercaseAAlt + 0192French Letter a Grave - LowercaseaAlt + 0224French Letter E Grave - UppercaseEAlt + 0200French Letter e Grave - LowercaseéAlt + 0232French Letter U Grave - UppercaseUAlt + 0217French Letter u Grave - LowercaseuAlt + 0249French Letter A Circumflex - UppercaseAAlt + 0194French Letter a Circumflex -
LowercasedAlt + 0226French Letter E Circumflex - UppercaseEAlt + 0202French Letter e Circumflex - LowercaseéAlt + 0234French Letter I Circumflex - UppercaselAlt + 0206French Letter i Circumflex - LowercaseiAlt + 0238French Letter O Circumflex - UppercaseOAlt + 0212French Letter o Circumflex - LowercasedAlt + 0244French Letter U
Circumflex - UppercaseUAlt + 0219French Letter u Circumflex - Lowercase{iAlt + 0251French Letter C Cedilla - UppercaseCAlt + 0199French Letter c Cedilla - LowercasecAlt + 0231French Letter E Umlaut - UppercaseEAlt + 0203French Letter e Umlaut - LowercaseéAlt + 0235French Letter I Umlaut - UppercaselAlt + 0207French Letter i
Umlaut - LowercaseiAlt + 0239French Letter U Umlaut - UppercaseUAlt + 0220French Letter u Umlaut - LowercaseiiAlt + 0252 Below is a step-by-step guide to type any of these Special French Characters with the help of the alt codes in the above table. To begin, open the document in which you want to type the Special French Letters. It could be
Microsoft Word, Excel, PowerPoint, or even in your web browser.Press the Num Lock key to turn it on. In other words, make certain that the numeric keypad’s keys are not disabled.Hold down the Alt key and type the alt code of the Special French character you want to type using the numeric keypad. The table above contains all the alt codes for the
various French Letters.Now release the Alt key after typing the alt code with the numeric keypad. NOTE: This option is only for Windows users. To type French Letters on Mac, refer to the next option. A keyboard shortcut is the quickest way to type French Letters on a Mac. Each letter with a French Accent mark has its own unique shortcut. They all,
however, use a very similar keystroke pattern. Let’s look at how to type any of these characters on a Mac using keyboard shortcuts. DescriptionFrench LettersShortcut for MacFrench Letter E Acuteé[OPTION]+[e] then eFrench Letter A GraveaOPTION]+["] then aFrench Letter E Gravee[OPTION]+["] then eFrench Letter U Graveu[OPTION]+["]
then uFrench Letter A Circumflexa[OPTION]+[i] then aFrench Letter E Circumflexé[OPTION]+[i] then eFrench Letter I Circumflexi{fOPTION]+[i] then iFrench Letter O Circumflex6[OPTION]+[i] then oFrench Letter U Circumflextif OPTION]+[i] then uFrench Letter C Cedillag[Option] + [Shift] + [C]French Letter E Umlauté[OPTION]+[u] then
eFrench Letter I Umlauti[OPTION]+[u] then iFrench Letter U Umlauti[OPTION]+[u] then u To use the Mac Keyboard shortcuts to type Special French letters with accent marks, first open the document that will contain the character and simultaneously press and release Option plus the corresponding key (see above table), then press the French
letter you want to type. Note: If you want to type uppercase French Letters on Mac, use the above hotkeys whilst your caps lock key is turned on. For more options on how to type these characters specifically in Microsoft Word, Excel, or PowerPoint, refer to the remaining sections below. NOTE: As shown already, using Option 1 (Alt code for
Windows) and Option 2 (shortcut for Mac), you can easily type French letters with Accent in Word. However, you can continue reading below if you want to learn more methods about how to insert these characters specifically into your Word document. In addition to the alt code method, there are two other ways to insert the French letters with
Accent in Microsoft Word. The first method involved using the insert symbol dialog box, while the second method involved using a keyboard shortcut that only works in Word. Let’s explore these options one after the other. To insert the French special letters using the insert symbol dialog box, obey the following instructions: Open up your Word
document and place the cursor where you want to insert the Character.On the Insert tab, go to Symbols > Symbol > More Symbols. The Symbol dialog box will appear. Select Latin-1 Supplement from the “Subset:” drop-down list. This will display all the symbols under this category including lowercase and uppercase French Letters.Locate the French
letter you wish to insert and double-click on it. Alternatively, click to select your desired French Letters and click on the Insert button to insert it into your document. These are the steps you may use to insert these symbols in Word using the Insert Symbol dialog box. Each of the French special letters has its own set of keystrokes. These keystrokes or
shortcut keys are only designed to function in Microsoft Word. Thus, if you want to type these symbols in a program other than Word, look into the other options in this post. Below are the various shortcuts to type French Letters in Microsoft Word: DescriptionFrench LettersShortcut for MS WordFrench Letter E AcuteéCtrl+’ (apostrophe), then
eFrench Letter A GraveaCtrl+" (accent grave), then aFrench Letter E GraveeCtrl+" (accent grave), then eFrench Letter U GraveuCtrl+" (accent grave), then uFrench Letter A CircumflexaCtrl+Shift+ "~ (caret), then aFrench Letter E CircumflexéCtrl+Shift+~ (caret), then eFrench Letter I CircumflexiCtrl+Shift+~ (caret), then iFrench Letter O
Circumflex6Ctrl+Shift+~ (caret), then oFrench Letter U CircumflextCtrl+Shift+~ (caret), then uFrench Letter C Cedillag[Ctrl] + [, ], [ ¢ ]JFrench Letter E UmlautéCtrl+Shift+: (colon), then eFrench Letter I UmlautiCtrl+Shift+: (colon), then iFrench Letter U UmlautiCtrl+Shift+: (colon), then u NOTE: These keystrokes will give you Lowercase
Special French Letters. However, if you want uppercase characters, turn on the caps lock whilst typing the shortcuts. These are the shortcuts for typing these letters in Microsoft Word. If you are using a Windows PC, you can easily type any letter with the French Accent mark in Excel. Mac users can also use the shortcuts stated in section two of this
tutorial. However, if you are looking for another way to achieve this specifically in Microsoft Excel, the steps below will show you. To insert Accent on French Characters in Excel: Launch Excel.Select the cell that will contain the character.On the Insert tab, click on the Symbols drop-down button and select Symbol from the list. The Symbols Dialog
box will appear. From the “Subset:” drop down list, select Latin-1 Supplement. All the symbols under this group will appear including all lowercase and uppercase French Letters. Click to select the particular French special letters you want to insert, then click on the Insert button. Alternatively, double click on the symbol to insert it into your Excel
document. These are all the steps needed to insert any of the French letters with Accent on top. See Also: How to type Special German Letters on Keyboard Just like on Microsoft Word and Excel, you can use the French letters with Accent alt code to type them into your PowerPoint document. However, if you want another way to perform this task
especially for PowerPoint, keep reading. To insert French letters with Accent in PowerPoint: Open your PowerPoint document.Place the insertion pointer on the slide you need the character.Go to the Insert tab on the ribbon. Click on the Symbols button to launch the Symbol dialog box. The Symbol dialog box will appear. From the “Subset” drop-down
list, select Latin-1 Supplement. You should see all the French characters under this category of symbols.Select the particular French letter you wish to insert and click on the Insert button. Otherwise, just double-click on the symbol you want to insert into your PowerPoint document. These are the steps you need to be able to insert the Special French
Letters in Microsoft PowerPoint using the Insert symbol dialog. Another easy way you can get the French Letters on any PC (whether Windows or Mac) is to use my favorite method: copy and paste. All you have to do is to copy the symbol from somewhere like a web page or the character map for windows users, and head over to where you need the
symbol (say in Word, Excel, or PowerPoint), then hit Ctrl+V to paste. Below are the French Letters for you to copy and paste into your Word document. Just select your desired symbol and press Ctrl+C to copy, switch over to your document, place your insertion pointer at the desired place, and press Ctrl+V to paste. Copy & Paste Special French
Letterséaeuaéiotcéiii You can also use the Character Map to copy and paste any symbol or character on Windows. It contains every symbol or character you can think of. Obey the following instructions on how to use the Character Map on any Windows PC. Click on the Start button and search for Character Map. The Character Map app will appear in
the search results, click on it to open. The Character Map dialog will appear.Select the French Letters you want to insert by double-clicking on it, it should appear in the Character to copy: field, then click on the Copy button to copy the symbol.Switch to your document where you want to paste the copied symbol, place the insertion pointer at the
desired location and press Ctrl + V to paste. This is how you may use the Character Map dialog to copy and paste any symbol on Windows PC. Among all these several options to type the Special French Characters, I think using the alt code method for Windows is the fastest option, provided you know the alt code for that particular symbol you want to
type. If you happen to use the Special French Characters often, you may consider making a cheat sheet for your reference. Using the keyboard shortcut to type French letters is also a handy method for Mac users. However, you can also use the mouse-based approach if you are inserting these symbols in any of the Office programs like Word, Excel, or
PowerPoint. Here is the list of French alt codes, French accent codes, Html codes, and their descriptions. You can copy and paste French accents marks into Word, Excel, and PowerPoint. Click on the French characters to copy. List of Alt codes for French letters with accents French accents marks on letters Symbol Description Alt Codes HTML Code
A Capital A with grave Alt 0192 A a Lowercase a with grave Alt 0224 a & Capital A tréma Alt 0196 A A Lowercase a tréma Alt 0228 & A Capital A with circumflex Alt 0194 A & Lowercase a with circumflex Alt 0226 & E Capital AE ligature Alt 0198 Z& s Lowercase ae ligature Alt 0230 se C Capital C with cedilla Alt 0199 C ¢ Lowercase ¢ with cedilla Alt
0231 ¢ E Capital E with grave Alt 0200 E & Lowercase e with grave Alt 0232 & E Capital E with aigu Alt 0201 E é Lowercase e with aigu Alt 0233 é E Capital E with circumflex Alt 0202 E & Lowercase e with circumflex Alt 0234 é E Capital E with tréma Alt 0203 E é Lowercase e with tréma Alt 0235 & I Capital I with circumflex Alt 0206 I i Lowercase i
with circumflex Alt 0238 1 I Capital I with tréma Alt 0207 I i Lowercase i with tréma Alt 0239 i O Capital O with circumflex Alt 0212 O 6 Lowercase o with circumflex Alt 0244 6 (E Capital Oe Ligature Alt 0140 (E ce Lowercase Oe Ligature Alt 0156 ce U Capital U with grave Alt 0217 U u Lowercase u with grave Alt 0249 U U Capital U with circumflex
Alt 0219 U (it Lowercase u with circumflex Alt 0251 @i U Capital U tréma Alt 0220 U ii Lowercase u tréma Alt 0252 {i How to Type French Letters with Accents using Keyboard Alt Codes? Make sure the numeric keypad is activated on the keyboard. Place the cursor where the French special character is required and then press and hold the Alt key and
type the required alt code value from the above list and release the alt key. Examples of Alt Keyboard Sequences Alt + 0192 = A Alt + 0228 = A Alt + 0200 = E If you want to know how to insert special characters & symbols using Windows Alt codes then please check out how to use Alt codes and also check the accents Alt Codes list. LetterLetter
TypeAlt Code AUppercase Accent Grave (A)0192 AUppercase Accent Circonflex (A)0194 AUppercase Accent Tréma (A)0196 EUppercase Ligature(AE)0198 CUppercase Cedilla (C)0199 EUppercase Accent Grave (E)0200 EUppercase Accent Aigu (E)0201 EUppercase Accent Circonflex (E)0202 EUppercase Accent Tréma (E)0203 IUppercase Accent
Circonflex (I)0206 TUppercase Accent Tréma (1)0207 OUppercase Accent Circonflex (0)0212 (EUppercase Ligature(OE)0140 UUppercase Accent Grave (U)0217 U'Uppercase Accent Circonflex (U)0219 U’Uppercase Accent Tréma (U)0220 aLowercase Accent Grave (a)0224 aLowercase Accent Circonflex (a)0226 daLowercase Accent Tréma (a)0228
eLowercase Ligature(ae)0230 ¢Lowercase Cedilla (c)0231 LetterLetter TypeAlt Code eLowercase Accent Grave (e€)0232 éLowercase Accent Aigu (e)0233 éLowercase Accent Circonflex (e)0234 éLowercase Accent Tréma (e)0235 iLowercase Accent Circonflex (1)0238 iLowercase Accent Tréma (i)0239 6Lowercase Accent Circonflex (0)0244
ceLowercase Ligature(oe)0156 uLowercase Accent Grave (a)0249 tiLowercase Accent Circonflex (u)0251 iiLowercase Accent Tréma (u)0252 Make sure you switch on the NumLock, press and hold down the Alt key, type the Alt Code value of the special French letter, for example, for lowercase accent grave e, type 0232 on the numeric pad, release the
Alt key and you got . *You must type, preceding 0. ** Above mentioned procedure is not aplicable for MacOS. For more information on how to use charecters, symbols, and emojis please check our How to use Alt-Codes? page. Bonjour, je veux apprendre le francais. (Hello, I want to learn French.) See that little appendage on the “c”? It’s an accent
mark, and it makes a huge difference in French pronunciation. This obviously begs the question—how do we type these symbols?Let’s take a look at all of the French accent marks, followed by creative ways totype French accent marks on English keyboards.ContentsFrench Accent MarkExamplel’accent aiguél’accent gravea, €, ul’accent circonflexea,
é, 1, 6, il’accent trémaé, i, illa cédillegl. L'accent Aigu — Acute Accent ( “ )The accent aigu looks like this: , a little apostrophe-like mark that floats up into the sky (é). This can only be on the letter e. Think of eggs or a tasty French omelette to help you remember this rule.The aigu is placed on the end of a word to indicate that the letter e is
pronounced like ay, as in marché (market), or parlé (spoken) or the place you’ve probably already visited several times this week, café . When the aigu is used at the beginning of a word, it often indicates that an s used to follow that vowel, for example étudiant (student) or étudier (to study): Un étudiant qui étudie a 1’école. A student who studies at
the school. 2. L’accent Grave — Grave Accent ( ~ )The accent grave looks like this: *. One clever way to remember the difference between the grave and its mirror image the aigu is to think of the English word “grave,” as in “I'm digging my own grave here.” The accent mark goes down, into the grave.The grave can be found on an a, e or u. However,
it only changes the pronunciation of the letter e. It makes the e sound like ehh.On the a and u, it helps distinguish between words that are spelled the same:3. L’accent Circonflexe — Circumflex ( " )L’accent circonflexe, or circumflex, is also called the hat or le petit chapeau (little hat). That’s easy to remember, isn’t it? This cute little hat goes on the a,
e,i,oand u (4, &, 1, 6, ).There are two good things about this accent that you will want to take note of. The first is its effect on pronunciation is so slight you won’t need to worry. In fact, there are some language reform groups who are in favor of getting rid of it.The second thing is that there really aren’t that many words in French that wear the
circumflex. You’ll probably run into the little hat if you travel and stay at a hotel (pronounced more or less like owe-tel, and almost identical to the English “hotel” without the “h”).Sometimes the circumflex is used as a marker to reference the old spelling of a word. With the word forét (forest), the accent indicates that an s once followed the vowel,
as it does in the identical English word “forest,” but over time was dropped. Think of it like a kind of gravestone that pays tribute to the original Latin version of the word.Aside from these, the circumflex has a more important job when it is used to distinguish between words with different meanings. This is when you want to make sure that it is worn
correctly. For example:With CircumflexWithout Circumflex du (past participle of devoir ) du (a contraction of de + le) di (owed) du (of the, some) mir (ripe) mur (wall) siir (sure) sur (on, upon)And, just to keep you on your feet, there are a few French words that use the little hat simply to give the word more prestige. Among them are: 4. L’accent
Tréma — Trema ( ~ )You know those two little dots that you sometimes see hovering above an e, i or u? That’s the tréma. It is used when two vowels are next to each other and both must be pronounced, as in naive , a word English has borrowed from the French, without the tréma.Usually, the “ is placed above the second of two consecutive vowels.
Think of the English word “coincidence,” which is actually pronounced “co-inn.” Coincidence is a French word, but in French it’s spelled coincidence . 5. La Cédille — Cedilla ( , )Enfin ! (At last!) We made it to the thumb, or the little tail as it’s commonly nicknamed.This little guy, the cédille, is present in other languages like Portuguese and Catalan,
but in French, it only goes under the letter c as so: ¢. Facile, no? (It’s easy, right?)The cédille is used to give the ¢ an s sound instead of a hard k sound—for example lecon (lesson) or francais (the French language), as in “Parlez-vous francais?” (Do you speak French?)You will also hear this often in the daily greeting, ¢a va? (How are you?)And then
there’s the infamous garcon (boy/waiter)! How to Type French Accent MarksNow that you know how to use the five French accent marks, how can you easily type them on a computer? Using a MacInternational KeyboardWith an international keyboard, French accent marks are easy to type. Here’s how you can set up an international keyboard on
Mac: Go to System Preferences.Choose “Keyboard,” then “Input Sources.”Click the + Sign, then choose “English” as the language to see a list of keyboards. Select “US International” and then “Add.” To type French accent marks, simply type the accent as you normally would, followed by the letter you want it to appear over. For example, to type 0,
hold down shift while pressing the “6” key (which is how you would type the ©~ symbol normally). Then type the letter “o0.” Voila!If you are using the international keyboard and want the symbol to appear on its own, and not over the following vowel, just hit the space bar after you type the symbol.To sum up:French accent mark: Shift + 6 + 0 =06
Symbol and vowel separate: Shift + 6 + space bar + o = "olt’s really intuitive, and takes no extra effort or time once you get used to how it works.Regular KeyboardYou can also stick with a regular keyboard and use pre-configured key combinations instead. Check this out:French LetterMac Key CombinationéOption + e, then release and type
egOption + caOption + °, then release and type aeOption + °, then release and type euOption + °, then release and type uaOption + i, then release and type aéOption + i, then release and type eiOption + i, then release and type i60ption + i, then release and type oiOption + i, then release and type uéOption + u, then release and type eiOption + u,
then release and type iiOption + u, then release and type ulf you want to type capital letters, just hold down Shift when you type the letter you want. Using a PCInternational KeyboardOn Windows 10: Head to the Start menu and click “Settings.”Click on “Time & Language.”Select “Language,” which is in the left column.Click on “English,” then
“Options.”Click on “Add a Keyboard,” then choose the “United States-International” option.On Windows 7:Head to Start, type “intl.cpl” in the Search box and hit the Enter key.Look for “Keyboards and Language,” and select “Change Keyboards.”Select “Add.”Click “English.”Select “United States-International” from the Keyboard list and click
OK.Under options, select “View Layout.”Under Default Input Language, select “English - United States-International” and click OK.In Regional and Language Options, click OK.Finally, on the desktop’s language bar, click “United States-International.”If you want to have this optional keyboard permanently, you can select the international keyboard as
your default keyboard from the dropdown menu while the keyboard menu is still open. You can also have a small keyboard icon stay on the menu bar at the bottom of the screen.Now that we have configured the international keyboard on PC, we can see how to type accents. All you have to do now is type one character and the letter it goes over. You'll
notice that it’s a little different if you’'re using a UK keyboard:French LetterWindows International Keyboard Shortcut (US)Windows International Keyboard Shortcut (UK)é' + eAltGr + ea” +a" + ae” + e  +eu + u + ug' + cAltGr + ca”™ + aAltGr + ™ + aé”™ + eAltGr + ™ + ei”™ + iAltGr + ™ + i6” + oAltGr + ™ + oU”™ + uAltGr + ~ + ué" + eAltGr + "
+ ei" + iAltGr + " + ii" + uAltGr + " + uTo type capital letters, just use the same codes while holding down Shift.Regular KeyboardOn a Windows PC, the codes for typing lower-case and upper-case letter accents are as follows. Be aware that you have to hold down Alt while typing the code.French Small LetterKeyboard Shortcut for Small
LetterFrench Capital LetterKeyboard Shortcut for Capital LetteraAlt + 133 or 0224AAlt + 01924Alt + 131 or 0226AAlt + 01944Alt + 132 or 0228AAlt + 142¢Alt + 135 or 0231CAlt + 1286Alt + 130 or 0233EAlt + 144&Alt + 138 or 0232EAlt + 02008Alt + 136 or 0234EAlt + 0202&Alt + 137 or 0235EAlt + 02031Alt + 140 or 02381Alt + 0206iAlt + 139
or 02391Alt + 02078Alt + 147 or 02440Alt + 0212uAlt + 151 or 0249UAIlt + 0217{0Alt + 150 or 0251UAlt + 0219iiAlt + 129 or 0252UAlt + 154Using LinuxBecause there are so many distributions of Linux, it is hard to give much advice about how to type French accents using the system. However, in Ubuntu, you can go to Menu, then “Character
Map” and then select the character you want. Alternatives to Typing with CodesIf all of this work to set up an international keyboard or memorize lots of codes seems too much for you, there are alternatives that might be easier. You can find point and click resources for inserting codes into your text:Typelt lets you type accents from many different
languages, including French. You will see a field where you can type, above which are buttons that include all of the accents. You could type accents here and copy and paste them into your word processor, or you could even type your entire text directly into the site.Lexilogos does basically the same thing as Typelt, but with more features included.
An advantage of Lexilogos is that it also includes a French dictionary and a spell checker.Your word processor will likely include the French character set—just check its website for instructions! In Microsoft Word, you can go to the Insert tab and click “Advanced Symbol.” Then just choose your font and look for the French character you want to
include.Now that you understand how essential it is to put the accents in their proper places, you’ll have an easier time pronouncing and writing French.Knowing the rules means you’ve earned the respect of French language speakers and you're one step closer to fluency. Congratulations! If you like learning French at your own pace and from the
comfort of your device, I have to tell you about FluentU. FluentU makes it easier (and way more fun) to learn French by making real content like movies and series accessible to learners. You can check out FluentU's curated video library, or bring our learning tools directly to Netflix or YouTube with the FluentU Chrome extension. One of the features
I find most helpful is the interactive captions—you can tap on any word to see its meaning, an image, pronunciation, and other examples from different contexts. It’s a great way to pick up French vocab without having to pause and look things up separately. FluentU also helps reinforce what you’ve learned with personalized quizzes. You can swipe
through extra examples and complete engaging exercises that adapt to your progress. You'll get extra practice with the words you find more challenging and even be reminded you when it’s time to review! You can use FluentU on your computer, tablet, or phone with our app for Apple or Android devices. Click here to take advantage of our current
sale! (Expires at the end of this month.) 124.3K Accent marks are a required aspect of writing in French, but many beginning French learners wonder if they really matter. They do! However, learning how to read and write French accent marks is only part of the battle. Since we live in the twenty-first century, it’s important to know how to type
French accents, too. But French accent marks don’t appear on most US English keyboards. The good news is that typing French accents is easier than it looks, and you don’t even need a French keyboard! Learning how to type French accents will help you whether you’re working with a French tutor, taking a language class, learning French words for
a trip to Paris, or just working your way through the basics of French grammar. This guide covers typing French accents on English keyboards for PC, Mac, and mobile devices—along with how to type accent marks in Word and Google Docs. French accent marks help to determine French pronunciation and distinguish between word meanings.
Learning how to use and type French accents accurately can help you communicate and have conversations in French for class, work, or travel. These are the five French accent marks and how they’'re used and pronounced. AccentUsagePronunciationExamplesaiguéaydesolé, médicin AccentUsagePronunciationExamplesgravea eiahehoohprobléeme,
deuxieme AccentUsagePronunciationExamplescédillegssfrancais, garcon AccentUsagePronunciationExamplestrémaéiiiayeeoohcoincidence, Zoé AccentUsagePronunciationExamplescirconflexeaéiotiahheheeohoohétre, hotel >>There’s a movement to remove the circonflexe from French, but it’s still important to recognize and know which words
include it! If you're wondering how to type an accent mark when you’re writing a paper, essay, or article, Google Docs and Microsoft Word both have features that allow you to insert special characters and type French accents that don’t appear on the keys. In Google Docs, start by clicking “Insert,” then “Special Characters.” Two drop-down menus
and a grid of symbols will pop up. Select “Latin” from the first drop-down menu, and then select the accented letter you want to type from the grid. In Microsoft Word, you also begin by clicking “Insert.” Next, click “Advanced Symbol.” If the “(normal text)” font doesn’t show up in the dropdown menu right away, navigate to the “Segoe UI Symbol”
font. A grid of symbols will pop up—select the accented letter you want to type and click “Insert.” You can easily type French accents on an Apple device with Option Key Accents codes and by using your keyboard. The modern Mac OS offers an exceptionally fast method of typing French accents, and it’s easy to use: AccentCodeaigu (é)Press Option +
e followed by the lettergrave (a, &, u)Press Option + ° (the key to the left of the “1”) followed by the lettercirconflexe (4, &, 1, 6, ))Press Option + i followed by the lettertréma (€, i, ii)Press Option + u followed by the lettercédille (¢)Press Option + ¢ Whether you're composing an email, writing in a doc, or using an app, you can use simple Mac keyboard
shortcuts to type French accents. Simply hold down a letter key on your keyboard until an accent menu appears. Once the menu is visible, you can use the arrow keys to move to the accent you want, or you can use the corresponding number key to choose an accent. A menu will only display if that letter has possible accents. Fortunately, Windows has
shortcuts that make it easy to type French accents without having to install an entirely new keyboard. To enter these codes for French accent marks, use a sustained key press—press each key one at a time, and hold it down until all the keys in the sequence are pressed down (note: don’t type the “+” symbol). You can also use the below keyboard
shortcuts in Word and Outlook to type French accents on a PC. AccentCodeaigu (é)Press CTRL + ‘ (apostrophe), followed by the lettergrave (a, e, u)Press CTRL + ° (the key to the left of “1”), followed by the lettercirconflexe (4, &, i, 0, 1) Press CTRL + Shift + 6, followed by the lettertréma (€&, i, i)Press CTRL + Shift + : (colon), followed by the
lettercédille (¢)Press CTRL + , (comma), followed by c If the above codes don’t work on your computer, try these Windows Alt codes for French accent marks by just using your number pad. Please note that you must have a separate number pad to use Alt codes. AccentAlt CodeAccentAlt
CodeéAlt+0233EAlt+0201aAlt+0224AAlt+01928Alt+0232EAlt+0200UAlt+0249UAIt+02174A1t+0226AAlt+01948A1t+0234EAlt+02021A1t+02381A1t+02076A1t+02440A1t+02120Alt+0251UAIt+02198A1t+0235EAlt+0203iAlt+0239TAlt+020711Alt+ 0252 UAIt+0220¢Alt+0231CAlt+0199 For iPhone, Android, and tablet keyboards, hold down any letter,
and French accent options will appear (with other non-French accents, as well). If you want to type “e” with an accent, hold down the “e” key, and you’ll instantly see these options pop up: € é € € € € é e € and o. Just click the one you're looking for, and keep on writing! If you need to do a lot of typing in French, you could get bogged down using
keyword shortcuts every time you need to type French accents. In this case, another option is to add an alternate keyboard layout in Windows. The options available for typing in French are the International keyboard, French keyboard, and Canadian French keyboard. The International keyboard is the most user-friendly to US-based users who are
used to a QWERTY-style layout. The French keyboard is AZERTY and has several keys in different places than a US English keyboard, which can make switching back and forth confusing. The Canadian French keyboard has all the unmodified letters in the same spots, but has some additional characters. When you use the International keyboard, be
careful when typing quotation marks and apostrophes before letters that accents aigu, cédilles, and trémas typically modify. If you don’t put an extra space between the punctuation and the letter, it’'ll assume that you want the accent mark. For example, for c’est not to become cést, you would have to type it as “c’ est” and then go back and remove
the space. AccentCodeaigu (é)Type ~ (to the left of 1), then the vowelgrave (3, e, u)Type ‘ (apostrophe), then the vowelcirconflexe (4, &, 1, 6, 1)Type ™ (shift + 6), then the voweltréma (€&, i, i)Type “ (shift + ‘), then the vowelcédille (¢)Type ‘ (apostrophe) then ¢ The typing of the accents themselves is easier on the French and Canadian French
keyboards. On the French keyboard, several accent marks are available as keys. On the Canadian French, fewer are available as keys, but the codes are simpler. AccentFrench KeyboardCanadian French Keyboardaigu (¢)On key: number 2Type / (forward slash), then egrave (a, €, u)On keys: number 0, number 7, apostropheType ‘ (apostrophe), then
the vowelcirconflexe (4, €, 1, 6, 1) Type [ (left square bracket), then the vowel (q on English keyboard = a on French keyboard)Type [ (left square bracket), then the voweltréma (&, i, ii)Type shift + [ (left square bracket) and the vowelType Shift + ] (right square bracket), then the vowelcédille (¢)On key: number 9Type ] (right square bracket), then c
Once you decide which keyboard add-on you want to use, here’s how to enable it: Go to “Settings.” Click on “Time & Language.” Click on “Language & Region.” Click on “English (United States).” Click on the horizontal three dots, and choose “Language options.” Scroll down to “Keyboards” and click on “Add a keyboard” and choose your language.
To toggle between keyboards, hold the Windows key and use the space bar to choose your keyboard language. For everything you need to start having conversations in the language of love, begin with the indispensable guide to learning French. Already started and need some help mastering the language? Check out the top French tutors on Wyzant!



